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PREFACE 

 

Today’s society is shaped by sudden growth and development of the 

information technology (IT) resulting with its great dependency on the 

knowledge and competence of individuals from the IT area. Although this 

dependency is growing from day to day, the human right to education and 

information is not extended to the IT area. Problems that are affecting 

society as a whole are emerging, creating gaps and distancing people from 

the main reason and motivation for advancement- opportunity. Being a 

computer illiterate person today means being a person who is unable to 

participate in modern society, being a person without opportunity and 

despite the acknowledged necessity and benefits of inclusive computer 

literacy from institutions like the European Commission, UNESCO, OECD, 

there are still groups of people having difficulties accessing basic computer 

education (persons with disabilities, persons with learning difficulties, 

migrant workers, unemployed persons, persons that live in remote (rural) 

areas where IT education is not accessible).  

This handbook, combined with other materials published on ITdesk.info, 

represent our effort and contribution to the realization and promotion of 

human rights to education and information considering the IT area. We hope 

that this education will help you in mastering basic computer skills and with 

that hope we wish you to learn as much as you can and therefore become an 

active member of modern ICT society.  

 

 

Sincerely yours,  

ITdesk.info team Lector of Croatian version: 
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OPERATIVE SYSTEM - OS 

MAIN ACTIONS 

Turn on your computer 

 The computer turns on by pressing the button  which is located on the computer case. 

 If necessary, enter the username and password. 

The proper procedure for restarting the computer: 

 

 

 

 

 

 

 

 

Fig. 1. Start Menu 

The Start Menu is the starting point of the system. Through this menu you can access programs, 
open frequently used folders, configure settings on the computer, access the Help function, shut 
down the computer or log off... 

The system can be restarted via Start menu: click 
the arrow next to the Shut Down button and then 
select the Restart command. 

 

 

 

 

 Fig. 2. Computer Restart 

 

Start Button  Search pane 
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Shutting down a non- responding application (End 
Task) 

If the application "freezes" and stops responding, the 
situation, in most cases, can be solved by pressing the 
key combination Ctrl + Alt + Del. Pressing these keys 
will open the Windows Task Manager. To close an 
application that does not respond, select it and press 
the End Task button. 

  

 

Fig. 3. Windows Task Manager 

The Reset button is used when the computer does not respond to our instructions ("froze up"). 
The Reset button is usually the button below the Start button on the computer case. After you 
have pressed it the computer shuts down and immediately starts again. 

Correct procedure for turning off the computer: 

The computer shuts down via Start menu, by 
clicking the Shut Down button.  

 

 

 

 

 

Fig. 4. Shutting down  

 

Using the Help function 

The Help function can be accessed from the computer desktop, by pressing the F1 key on the 
keyboard. Windows Help and Support opens with a search box in which you can enter terms that 
are of your interest or you need help on. If you press F1 while in an active window or program 
(e.g. Microsoft Word), the Help function will relate to that program specifically. 
Another way to access the Help function is through the the Start menu  Help and Support 
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 Fig. 5 Help function 

 

GENERAL INFORMATION AND SYSTEMIC OPERATIONAL SYSTEM SETTINGS 

System Information 

 In the Start menu → right click on Computer, then choose the Properties command from 
the quick menu, or 

 Right-click on icon    found on your desktop → choose the Properties command 
from the quick menu, or  

 Start  Control panel  System, or 

 The key combination Windows + Pause 

It will open a window that shows information about the operating system installed on your 
computer and some basic information about the computer (processor type, installed memory). 

Date and Time 

To change the time and date you need to click on the time  

  shown in the lower right corner of the taskbar. Click on 
Change date and time settings in the window opened (Figure 6). 

 

 

Fig. 6. Date and time  
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Speaker Volume 

In order to change the speaker volume, you need to click on the icon    in the lower 
right corner of the taskbar. By moving the vertical scroll bar you can change the volume. 
Pressing the Mute Speakers button   turns off the sound. 

 

Fig. 7. Adjusting the speaker volume 

 

Desktop Background 

The appearance of your desktop background can be changed in the following manner: position 
your cursor over the desktop, press the right mouse button and select the command Personalize 
from the Quick menu. In the opened window, click on Desktop Background and choose from any 
of the listed files, or click the Browse button and choose another image stored on the computer. 

It is also possible to select multiple background images that, in a given period of time, change on 
the screen, similar to screen saver. Just mark the images you want to display and then in the 
drop-down menu Change picture every select the change interval.  

 

 

 

 

 

 

Fig. 8. Changing the 
background 

 

 

Screen Saver 

To set the Screen Saver, position the cursor over the desktop and press the right mouse button 
(the quick menu will open) and choose the option Personalize. In the opened window select the 
Screen Saver icon.  
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Fig. 9. Dialog box  
Screen Saver 

 

 

Resolution 

To change the screen 
resolution, press the right 
mouse button over the 
desktop and select the Screen 
resolution command from the 
quick menu. 

  

 

 

Fig. 10. Setting the screen 
resolution 

 

Control Panel 

The Control Panel is a special folder in which you can adjust the system settings through various 
system setting options (install and uninstall programs, adjust the keyboard, mouse, sound ...). 
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The Control 
Panel is 
accessed via 
Start menu  
Control Panel. 

 

 

 

 

 

Fig. 11. Control 
Panel –Small 

icons view 

 

Selecting and adding the keyboard language. 

In the Control Panel open the Region and Language icon and select the Keyboard and Language 
tab, then select the Change Keyboards button. In the group Installed services click on the Add 
button. Select the language you want to add and double-click on the Keyboard. Confirm by 
pressing the OK button. 

             

Fig. 12 Keyboard and Language    Fig. 13 Installed services group 
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  Fig. 14 Add input language 

Change the input language of the keyboard 

On the Language Bar, click the input language button (in this case 
Croatian is chosen) and then select the input language you want to use.  

 

Fig. 15 Change input language keyboard 

 

Program management  

Installing new programs: 

 From CD, DVD, Internet, network 

 When installing from a CD or a DVD, in most cases the dialog box will automatically open 
the Autorun function, through which the Setup Wizard can be started 

 If the installation of the program does not start automatically, you can start the 
installation manually by double-clicking on the file typically called Setup.exe or Install.exe 

 After the Wizard installation has started, follow instructions and go to next steps by 
pressing Next, Yes, buttons etc. You will usually have to accept license terms, choose a 
location where the program will be installed, possibly choose components of the program 
you want to install etc. At the end press the Finish or Close button. 

Uninstalling the programs 

On the Control Panel double-click the Programs and Features icon, choose the software you 
want to uninstall and click the Uninstall button. 

 

http://creativecommons.org/licenses/by-nc-nd/3.0/hr/
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Fig. 16 Uninstalling 
programs 

 

Using the «print screen» key on the keyboard 

By pressing the Print Screen key, the image currently on the screen is temporarily stored in the 
buffer (clipboard). To see the image and edit it, open any software for image editing like the 
Paint program and simultaneously press the Ctrl and V keys on the keyboard in order to paste the 
image in the imaging software. If you want to capture only active windows, use the keyboard key 
combination Alt + Print Screen and the rest of the process is the same. 

The Paint program comes with windows and can be accessed via Start menu  All Programs  
Accessories  Paint. 

 

ICONS 

Icons are small pictures (pictograms) on a computer screen and they all represent programs, 
folders, files and shortcuts.  

A double click on a program icon will start the appropriate program. 

A double click on the folder icon will open a window that shows files and folders contained in that 
folder. 

A double click on the file icon will start the appropriate program and open that file in an 
appropriate program. 

Shortcuts are files that point to other programs, program files or folders found somewhere on the 
computer. A double click on the shortcut icon will start either the appropriate program, or the 
appropriate file and corresponding program or appropriate folder. 

http://creativecommons.org/licenses/by-nc-nd/3.0/hr/
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 Microsoft Excel 2010 shortcut icon 

 Microsoft Word 2010 shortcut icon 

 Microsoft Access 2010 shortcut icon 

 Microsoft PowerPoint 2010 shortcut icon 

 Folder icon 

 Computer icon 

 Recycle Bin icon 

Select and move (one or more) icons. 

An icon is selected by a click on the icon it with the left mouse button. To select multiple icons at 
once: 

 press and hold down the left mouse button, then pull the mouse across the icons and 
release the mouse button, or 

 Fig. 17. Select several icons using the above mentioned method 

 select an icon, press and hold down the Shift key, press the last icon in a row and release 
the Shift key (selecting consecutive icons), or 

 press and hold down the Ctrl key and select the non-consecutive icons using the left 
mouse button. 

http://creativecommons.org/licenses/by-nc-nd/3.0/hr/
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Icons are moved via the drag-and-drop method – press and hold down the left mouse button 
over the icon, drag the mouse (with the icon) to a new location and release the mouse button 
(which places the icon in the new location). 

Desktop shortcuts 

To create a shortcut: 

 press the right mouse button on the 
desktop 

 From the quick menu choose New  
Shortcut 

 click on the Browse button and 
search for a folder, program or file 
the shortcut is being made for 

 press the button Next to confirm 

 enter the name of the shortcut (or 
leave the existing one) and end this 
action with the Finish button  

Fig. 18. Create a shortcut 

E.g. if you want to create a desktop shortcut for the folder Music: 

 open the Start menu 

 press the right mouse button 
over the folder Music 

 on the quick menu choose the 
Send to option 

 choose the Desktop (create 
shortcut) option 

 

 Fig. 19. Create a shortcut 

 

Using icons  

In order to open an icon: 

 double-click on it with the left mouse button, or  

 select it and press the Enter key on the keyboard 

Shortcut is an icon with a recognizable arrow  in the lower left corner. The shortcut links you 
with the file or program. It opens like any other icon; double-click on it with the left mouse 
button. 

http://creativecommons.org/licenses/by-nc-nd/3.0/hr/
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BASIC ACTIONS WITH WINDOWS 

You can have several windows opened at the same time, but only one will be active: 

 The active window has a highlighted border and the inactive window is grayed out 

 The opened window becomes active if you press the left mouse button on it, or 

 The opened window becomes active if you press the left mouse button on its section on 
the taskbar  

We can move windows using the drag-and-drop method: press and hold down the left mouse 
button on the title bar, drag the window to where you want to move it and release the mouse 
button. 

Recognizing different elements of a window: title bar, menu bar, toolbars, status bar, 
scroll bar. 

 

 

 

 

 

 

 

 

Fig. 20. Window elements 

Dialog box 

The dialog box is a specific type of window that offers 
choices related to a certain task. Confirm an action by 
clicking the OK button, or cancel it by clicking the Cancel 
button. Unlike regular windows, their size is fixed.  

 

 

Fig. 21. Dialog box 

Manipulation 
buttons 

Title bar 

Menu bar 

Border 
Slider 
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Window manipulation buttons are located in the upper right corner of the window’s title bar. 

 The Minimize button – minimizes the window to the taskbar 

 The Restore Down button - restores the window to the size before maximization  

  The Maximize button - spreads the window over the entire desktop  

  The Close button - closes the window 

Resizing the window:  

Using the cursor position over the window border and when the mouse pointer changes its shape 
into , press and hold down the left mouse button and drag the mouse. Using this method you 
can resize the window according to your needs. 

 Switching between a number of windows opened: 

 using the left mouse button to select and activate the desired window - this is possible 
only if the desired window is at least partially visible  

 using the left mouse button to select and activate the desired window from the taskbar – 
the selected window appears above all others and becomes active 

 using the key combination Alt + Tab will open a pane showing all opened windows 
(Fig.22). Hold down the Alt key and press Tab consecutively to move between opened 
windows. When the desired window is selected, release the Alt key. 

 

Fig. 22. Switching between multiple opened 
windows- Alt + Tab 
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WORKING WITH FILES 

BASIC CONCEPTS 

A File is a set of digital data. Each file has a name, an icon (assigned by the operating system) and 
an extension. Files are placed within folders (for easier reference). To browse computers for files 
and folders you use Windows Explorer. 

Run Windows Explorer: 

 position the cursor over the Start button, press the right mouse button and select the 
command Open Windows Explorer, or 

 from the Start menu select All programs, in the folder Accessories find and click Windows 
Explorer, or 

 in the search box (within the Start menu) type "Windows Explorer" and click on it when it 
appears in the results, or 

 click on  in the Taskbar, or 

 click on the Windows Explorer shortcut on the desktop  

 

 

 

 

 

Fig. 23. Windows  
Explorer – Libraries 

 

There are four types of libraries: 

 The Document library – this library is used for organizing and saving documents (text files, 
workbooks, presentations…) 

 The Pictures library – it is used for organizing and saving pictures 

 The Music library – it is used for organizing and saving music 

 The Video library – it is used for organizing and saving video materials  

Each file and folder has its path – an address of its location. 
 
 Fig. 24. Address bar - path to the 
folder Sample Music  
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Create a new folder in the Music library: 

 open Windows Explorer 

 open the Music library 

 press the New Folder button on the window address bar 

 enter a name for this folder  

 

 

 

 

 

Fig. 25. Create a new 
folder 

 

 

Storage devices and hierarchical display of files and folders. 

Each device has an icon, name and letter in the parentheses (A, B, C, D, E,...) 

There can be one or more Hard Disk Drives on the computer, or there can be one HDD divided 
into partitions 

A Floppy Disc      

When the hard disk is not 

divided into partitions 

and the DVD-ROM is 

connected 

When the hard disk is not 

divided into partitions and 

the DVD-ROM and CD-RW 

are connected 

When the hard disk is divided 

into two partitions and the DVD-

ROM and CD-RW are connected 

C Hard Disk Drive C Hard Disk Drive C 
Hard Disk Drive (first 

partition) 

D DVD-ROM D DVD-ROM D 
Hard Disk Drive (second 

partition) 

  E CD-RW E DVD-ROM 

    F CD-RW 

Devices used by the operating system for data storage are marked with capital letters (eg:  
Floppy(A:) ; Local Disk(C:); Removable Disk(E:) etc.) and are available in My Computer. 

http://creativecommons.org/licenses/by-nc-nd/3.0/hr/
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Data storage devices are:  

 Floppy 

 Hard Disk – the device for permanent storage 

 Network Drive – the hard drive that can be accessed through the network 
o to access it open the folder My Network Places 

 USB stick  

 CD-RW (Compact Disk Re-Writable)  

 DVD-RW  

Measurement unit, size of files and folders: KB, MB, GB 

1 KB (kilobyte) - 1024 bytes  

1 MB (megabyte) - 1024 kilobytes  

1 GB (gigabyte) - 1024 mega bytes  

 

Why is it necessary to make additional copies of important files on removable storage 
devices? 

It is recommended to create back-up copies of important files in case the original files become 
inaccessible, either to drive failure, accidental deletion or other reasons. If you have a back-up 
you can restore original files. Backup is done mainly on removable storage devices. 

 

The advantages of storing data on network devices 

If the computer is connected to a network, you can access shared data (shared with other users 
on the network): to access network disks open the My Network Places folder usually found on 
the desktop or within the Start menu. 

  

http://creativecommons.org/licenses/by-nc-nd/3.0/hr/
http://creativecommons.org/licenses/by-nc-nd/3.0/hr/
http://creativecommons.org/licenses/by-nc-nd/3.0/hr/


ITdesk.info – project of computer e-education with open access 

ITdesk.info is licensed under a Creative Commons Attribution- 

Noncommercial-No Derivative Works 3.0 Croatia License. 16/29 

FILES AND FOLDERS 

Folder properties dialog box 

Click the right mouse button over the folder and 
choose the Properties command from the quick 
menu. In the opened dialog box under the tab 
General you can find information about the name, 
size and location of the folder. 

 

 

 

 

Fig. 26.Dialog box - folder properties 

  

Manipulating window size 

Sometimes when the window is not maximized you can’t see all the information about the 
devices, folders or files. You can use vertical and / or horizontal sliders to slide through and see 
complete contents of the window. You can also customize the window size (height and / or 
length) so that the entire content is visible. To adjust the window size place the cursor (mouse 
pointer) over the edge of a window and when the mouse pointer changes shape, press and hold 
the left mouse button, drag the edge of the window and release the left mouse button. 

Changing height and width of the window simultaneously can be done by positioning the mouse 
pointer over any corner of the window and using the method „drag-and-drop” to achieve the 
desired window size. 

Using Windows Explorer 

Windows Explorer displays a hierarchical view of folders and files. To start Windows Explorer do 
one of the following: 

 Windows Explorer, or 

 from the Start menu select All programs, in the Accessories folder find and click Windows 
Explorer, or 

 in the search box (within the Start menu) type "Windows Explorer" and click on it when it 
appears in the results, or 

 click on  in the Taskbar, or 

 click on the Windows Explorer shortcut on the desktop  

http://creativecommons.org/licenses/by-nc-nd/3.0/hr/
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 Fig. 27. Windows 
Explorer 

 

Navigation pane (left side of the window) - displays the entire folder structure. To expand maps 
press ; folders with  are branched - expanded. If you wish to see the content of a certain 
folder, select it in the left pane and in the right part of the window the folder content will be 
displayed.  
You can also navigate through folders displayed in the right part of the window using the left 
mouse button double click and the address bar. 

 

Creating a folder and subfolder 

To create folders on the desktop: press the right mouse button on the desktop and from the 
quick menu choose the commands New → Folder → enter name →press Enter key. 

        

Fig. 28. Empty folder icon      Fig. 29. Folder icon with content 

To create a subfolder using Windows Explorer: in the navigation pane (left) select the folder you 
want to create a subfolder in, and on the toolbar choose: New Folder → enter name → press 
Enter key, or press the right mouse button in the right part of the window and choose: New → 
Folder → enter name →press Enter key 
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WORKING WITH FILES 

A file is defined by a name and an extension. The extension indicates the file type (text, 
multimedia ...) and tells the computer which application is appropriate for that file type. 

File extensions of some frequently used files are: 

.exe – executable files 

.sys, .dll - system file 

.tmp, .temp – temporary  

.rar, .zip, .7z – compressed files 

.jpg, .jpeg, .gif, .png– image type 

.mp3, .wav, .wma– audio file 

.avi, .wmv, .mpg, .mp4 – video - multimedia file 

.txt, .odt, .doc, .docx – text files 

.ods, .xls, .xlsx – spreadsheet files 

.odp, .ppt, .pptx – presentation files 

.dbf, .mdb, .accdb – database files 

.pdf – (Portable Document Format)  

.htm, .html, .asp, .aspx, .php - web 

 

Notepad 

The Notepad is a simple text editor with limited 
options for text formatting. 

The Notepad can be accessed via Start menu and 
then clicking on All Programs → Accessories → 
Notepad. 

 

 Fig. 30. Notepad 
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To save a file for the first time, select Save As from the File menu. In the dialog box that appears 
specify the location you want to save the file in (Save in field) and the file name (File Name field). 

or just click the Save command. Saving can be done using the keyboard key combination Ctrl + S 

or the icon  located in the Toolbar. 

File attributes 

To change a file / folder status, you need to access the file / folder attributes. Press the right 
mouse button over the file and select Properties from the quick menu. In the lower part of the 
dialog box there are options for Read Only and Hidden. If you select the Read only attribute 
option, the file can be opened and changes can be made, but when you try to save the file you 
will only get the Save As dialog box. Saving the file is possible only under a different name and 
the original file will not be changed due to the Read Only attribute. 

If you select the Hidden attribute, the file or folder will become 
invisible in Windows Explorer, provided that the OS is set not to 
display hidden files or folders (this option is found in Windows 
Explorer: choose tools->folder option- >tab “view”, the option is 
called “show hidden files and folders 

”  ). If marked, hidden files and 
folders will be visible in Windows Explorer, but they will also be 
transparent and if this option is not marked, files or folders will be 
invisible therefore hidden. When you have selected the desired 
attributes, you confirm them by clicking the OK button. 

Fig. 31.Dialog box Properties – option Hidden is marked 

 

Option view   

You can choose among available views using the  button found on the window toolbar: 

Extra Large Icons 

Large Icons 

Medium Icons 

Small Icons 

List 

Details 

Tiles 

Content     Fig. 32. View files 
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Fig. 33. Windows Explorer window – view: Details 

 

Files can be sorted (Arrange by) according to name, size, type and creation date.  

 

Fig. 34. Sorting files  

When naming files or folders you should choose meaningful names, names that indicate their 
content. 

Address 
bar 

Navigation 

buttons 

Manipulation 

buttons 
Search pane 

Toolbar 

Navigation 

pane 

View button 
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Renaming files and folders 

Renaming a file/folder: 

 press the right mouse button on the file or folder and from the quick menu select the 
Rename command. Type in the new name and press the left mouse button next to the 
icon or just press Enter. 

 select the file / folder and press F2 

 select the file / folder and after a few moments press the left mouse button 

 

ACTIONS WITH FILES AND FOLDERS 

Select files or folders 

Select files / folders with a left mouse button click.  

 If you want to select consecutive files / folders: 

o press and hold down the left mouse button, drag the mouse over the files or folders 
until the group of files / folders is highlighted, or 

o select the first file with the left mouse button, hold down the Shift key and select the 
last consecutive file or folder with the left mouse button. All files or folders in between 
will be selected (selecting consecutive files / folders) 

o selecting non-consecutive files or folders: select the first file with the left mouse button, 
hold down the Ctrl key and then select other files one by one. After you have selected 
all of the desired files, release the Ctrl key. 

To select all files in a specific folder: Edit → Select All, or use the keyboard shortcut Ctrl + A. 

To copy files / folders, open Windows Explorer and: 

 in the navigation pane find and select the file/folder you want to copy  

 press the right mouse button and from the Organize menu choose Copy  (Ctrl + C) 

 via navigation pane find and select the folder you want to copy the file or folder into 

 press the right mouse button and from the Organize menu choose Paste  (Ctrl + V) 

Copying using the drag-and-drop method: 

 select the file/folder you want to copy  

 over the selected file/folder press and hold down the mouse button then press and hold 
down the Ctrl button 

 drag the mouse pointer (with file or folder) to a new location 

 release the mouse button and after that release the Ctrl key. The file or folder is pasted to 
the new location. 
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To move files or folders open Windows Explorer and: 

 in the navigation pane find and select the file/folder you want to copy  

 press the right mouse button and from the Organize menu choose  Cut   (Ctrl +X) 

 via navigation pane, by using the cursor, position on the place you want the content 
copied to 

 press the right mouse button and from the Organize menu choose Paste  (Ctrl + V) 

To move files/folders via the drag-and-drop method use the same steps as for copying, not 
including the use of the Ctrl key. 

Delete files and folders by moving them into the Recycle Bin: 

via Windows Explorer: 

 in the navigation pane select the location the files/folders you want to delete are in, then 
in the right window select the files/folders you want to delete. From the Organize menu 

choose Delete  

 press the right mouse button over the file/folder and from the quick menu choose Delete 

via the drag-and-drop method:  

 press and hold down the left mouse button over the file/folder you want to delete, then 
drag the mouse cursor to the Recycle Bin and release the mouse button 

Select the file/folder you want to delete and press the Delete key  

 

To Restore deleted items from the Recycle Bin: 

Deleted items (files, folders, shortcuts) can be restored from the Recycle Bin to their original 
location on the computer before deletion. After opening the Recycle Bin (by double-clicking on 
the Recycle Bin icon) use the following commands on the toolbar: 

Restore all items – restores all items from the Recycle Bin to their original location on the 
computer 
Restore this item – to make this command available, first select the file/folder you want 
to restore  
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 Fig. 35. Recycle Bin 

Empty the Recycle Bin 

 via Recycle Bin window toolbar – the Empty the Recycle Bin command permanently 
deletes files/folders from the computer, or 

 press the right mouse button on the Recycle Bin icon found on the desktop – from the 
quick menu choose the Empty Recycle Bin command 

 

SEARCHING DATA STORAGE DEVICES 

Use Windows Search function to find files, folders and programs. In the search parameters you 
need to enter data you know about the item (name, part of the name, file type (extension), 
creation date ...). 

You can search for a file via: 

• Start menu by entering part of the text in the search box. While entering the text 
in the Start menu, items that match the input text appear 

• search box found in the upper right corner of any opened window 

Search data storage devices using the date of modification or creation, or using the size criteria: 

In the upper right corner of the opened window, click on the search box and add a search filter. 

Date modified – searches for files according to the date they were modified 
Size – searches for files according to their size 

 Fig. 36 Add search filter 
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Search data storage devices using wildcards: file types, or the first letter of the file name. 

If you cannot remember the name of the requested files, use wildcard characters: asterisk (*) and 
a question mark (?) instead of letters. In the All or part of the file name field enter the extension 
of the document you want to find: 

 *.*txt  lists all files with the extension .txt, 

 *.*bmp  lists all files with the extension .bmp, etc. 

You can also search by using some of the file names letters: 

 b*.* lists all files which name begins with the letter b 

 b???? lists all files which name begins with the letter b and contains 5 letters in total 

*t.* lists all files which name ends with the letter t 

 

List of recently used files 

The required documents can often be found on the list of recently used files. It is necessary to 
access the Start menu and click on the arrow next to the application you have used and the list of 
recently used files will be shown.  
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UTILITIES 

WORKING WITH COMPRESSED FILES 

By zipping (compressing) files, space occupied by data on the disk is reduced. Programs for 
compressing files are also used for compressing a large number of files and folders into a single 
compressed file. Some of the popular programs for compressing files are WinZip, WinRar, 7-zip ... 

Adding files to a compressed folder 

 

 

Fig. 37 Send to - Compressed (zipped) Folder 
command 

Press the right mouse button on a file or folder and from the quick menu choose the command 
Send to → Compressed (zipped) Folder. At the location you are currently at, a zipped file will be 
created with the same name and .zip extension. If you want to add a file or a folder to the 
compressed file, just drag it over the compressed folder using the drag-and-drop method. 

 Fig. 38 Compressed file icon 

Decompressing / extracting a compressed folder 

 Fig. 39. Extract files command 

Click the right mouse button over the compressed folder, select the Extract files command and 
specify the location you want to extract and store them in. 

 

VIRUSES AND ANTI-VIRUS SOFTWARE 

A virus is a malicious program with the possibility of auto-replication. It searches for files within 
the computer trying to infect them and the ultimate goal is to spread to other computers. 
Depending on what malicious code it contains, it can cause more or less damage to your 
computer. Viruses are usually spread by e-mail attachments, infected files on removable media 
etc. 

For example, if you want to examine (scan) a device, a folder or a file by using the Avira AntiVir 
Personal antivirus software, you can do so by selecting it, pressing the right mouse button over it 
and selecting the command Scan selected files with AntiVir from the quick menu. 
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Fig. 40. Scan selected files with antivirus software 

Antivirus software (Norton, McAfee, Sophos…) is used to find and remove malicious software. 
Antivirus software needs to be updated regularly (the best is to set it to work automatically when 
connected). If you do not do so, your antivirus program becomes useless because it cannot detect 
new types of malware. 

There is an icon of the installed antivirus program on the taskbar: right-click on its icon and you 
will see the option for Start Update. 
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MANAGING PRINTING 

Select a printer from the list of installed printers found in the Start menu → Devices and Printers 

If there are multiple printers, only one is default which is automatically used for printing unless 
specified otherwise. You can change the default printer via Start menu → Devices and Printers - 
then select another printer, click with the right mouse button on it and from the quick menu 
select the Set as default printer command. 

Install / add a new printer to the computer 

  via Start menu → Devices and Printers - on the command bar choose Add a printer 

 use an installation CD printer provided with the printer when purchased 

Print a text document from a word processing software 

From the File menu, select the Print command. Once you've set the print options (number of 
copies, print certain pages ...) press the OK button. 

Program for printing control  

If you want to check what is currently on print, from the Start menu select Devices and Printers 
and right-click on the printer icon and from the quick menu select the See what's printing 
command. 

To stop the current document from printing, press the right mouse button over the document 
name in queue and from the quick menu select the Pause command. To continue printing the 
document, choose the Resume command. If you want to stop printing the document – from the 
quick menu click on the Cancel command and confirm the action by clicking the Yes button. 
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This handbook is intended for learning in conjunction with materials 
published on the following links: 

 

*Notes: 

http://www.itdesk.info/Basic computer use notes.pdf  

 

* Video presentations showing basic computer use and managing files: 

 Using Windows XP - presentation 1 

 Using Windows XP - presentation 2 

 Using Windows XP - presentation 3 

 

* Sample exam: 

http://www.itdesk.info/sample exam/sample exam module 2.pdf 

 

 * Solution for this sample exam:  

http://www.itdesk.info/en/exam-solution-module-2/ 

 

*Quiz for self-evaluation: 

 using the computer and managing files - quiz 

(to open the link contained within the .PDF document, just press the left mouse button on one of  links 
above. The web page the link points to will open in a browser that you have installed on your 
computer.) 
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Terms of use:  

All freeware programs and services listed on the ITdesk Home Website at ITdesk.info are the sole 

property of their respective authors. Microsoft, Windows and Windowsxx are registered 
trademarks of the Microsoft Corporation. Other registered trademarks used on the ITdesk Home 
Website are the sole property of their respective owners. If you have questions about using or 
redistributing any program, please refer to the program license agreement (if any) or contact: 
info@itdesk.info.  

These sites contain links to other websites or resources. The ITdesk.info team is not responsible 
for the text and / or advertising content or products that are on these sites / resources provided, 
as it is not responsible for any content that is available through them, nor the possibility of the 
inaccuracy of the content. Use links at your own risk. Also, the ITdesk.info team does not 
guarantee:  

- that the content on this website is free from error or suitable for any purpose,  

- that these websites or web services will function without error or interruption, 

- will be appropriate for your needs  

- that implementing such content will not violate patents, copyrights, trademark or other 

rights of a third party.  

If you disagree with the general terms of use or if you are not satisfied with the sites we have 
provided, stop using this website and web services. ITdesk.info team is not responsible to you or 
any third party for any resulting damages, whether direct, indirect, incidental or consequential, 
associated with or resulting from your use or misuse of this website or web services. Although 
your claim may be based on warranty, contract violation or any other legal footing, regardless 
whether we are informed about the possibility of such damages, we shall be released from all 
liability. Accepting the limitations of our responsibilities is a necessary prerequisite of using 
these documents, web pages and web services. 

Please note that all mentioned software, in this or other documents published on ITdesk.info, is 
stated only for educational or exemplary purposes and that we, in any case or manner, do not 
prefer these software over other similar software mentioned or not mentioned in the materials. 
Any statement that would suggest that we prefer some software over others mentioned or not 
mentioned in the materials, will be considered as false statement. Our direct and unconditional 
support is only to open source software that allows users to become digitally literate, use a 
computer and participate in the modern information society without barriers. 

  

The website http://www.ITdesk.info  was launched by a non-governmental 
organization "Open Society for the Idea Exchange“ in order to actively promote the 
human right to free access to information and the human right to education.  
Feel free to copy and distribute this document, provided that you do not change 
anything in it!  
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